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Chapter 1 

Typesetting a Book in WSPC Style 

Using MS Word 

This article is intended for authors using WSPC's MS Word template for 

typesetting books. MS Word is a word processing program that can be 

used to create, edit, format, and save documents. Although this document 

is not meant to be a complete reference for using MS Word—since none 

can replace MS Word Help function which is always available “down-to-

earth”—it provides a tutorial-refresher aid for typesetting WSPC books 

using MS Word on technical grounds. 

1.1   Introduction 

Authors who use this template correctly should find that writing their 

book is easier. Their output will be in a form that is suitable for camera-

ready copy. In addition, it will also be produced faster, with flawless 

typographical errors, besides automatically fitting the in-house style by 

default. 

Detailed instructions for the preparation of the book using MS Word, 

including notes on preparing text which comprises Parts, Chapters, 

Section headings; Lists; Floats that include Tables and Figures; 

Mathematics; Miscellaneous; and References are described elaborately in 

this chapter. 

1.2   Loading a Template 

Loading the content (chapters) into the desired template entirely depends 

on three factors. 
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(1) If the chapter text is yet to be created, then open a new document 

from the menu File | New or Ctr + N. 

(2) For already created chapter text, open your existing document from 

File | Open or Ctr + O. 

(3) Now select the WSPC template: 

 For Office 2003, XP and Office 97 users: 

(i) Click Tools | Templates and Add-ins menu. 

(ii) Click the Attach button in the Templates and Add-ins 

dialogue, 

(iii) Switch to the folder that contains the WSPC template you 

want, double click the appropriate template/style file from the 

file selector. Then ensure that the check box—Automatically 

Update Document Styles—is attended before clicking OK in 

the Templates and Add-ins dialogue. 

 For Office 2007 users: 

(i) Click the Microsoft Office Button , and then click Word 

Options. 

(ii) Click Add-Ins. 

(iii) In the Manage list, select Word Add-ins, and then click Go. 

(iv) Click the Templates tab. 

(v) Under Global templates and add-ins, select the check box 

next to the template or add-in that you want to load. If the 

template you want does not appear in the box, click Add, 

switch to the folder that contains the WSPC template you 

want, click it, and then click OK. 

For the already created content, you may switch off the section auto 

numbering option  to avoid double numbering. 

 If you are not sure with the above process, the template can be retained 

in the current working folder and double clicking it should open a new 

chapter whenever the need arises. 

Regardless of the method employed (as explained above), the WSPC 

styles will be available in the Styles list box on the Formatting tool bar, 

and in the Styles and Formatting on the Format menu. It is also 
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necessary to click 9"x6" from WSPC toolbar to have a required page 

layout when the template is attached to an existing document. 

1.2.1   Applying WSPC styles to the document 

To apply a style, begin by selecting the text to which the style needs to 

be applied, and then choose the style name from the styles list box on the 

tool bar or by using WSPC Toolbar. The WSPC templates contain all the 

styles that is required for formatting the documents. It is crucial and 

recommended to exploit the usage of styles as much as possible to format 

the text. However, apply direct formatting only as a last resort when the 

style, for some reason, is incompatible with the requisite. As a note of 

caution, do not use any style for a purpose other than that for which it 

was intended or for the want of effort. 

1.3   Combined TOC and Index using RD Fields 

When its time to create the Table of Contents or Index that spans the 

entire project, and perhaps ensuring that all the page numbers are 

consecutive, RD fields are the most stable mechanism in Word for this 

purpose. With predefined TOC and Index fields present at the master 

template, TOC and index entries are automatically generated using these 

RD fields. RD fields identifies a file to be included when you create a 

table of contents, or an index, e.g., 

{ RD "C:\\books\\Chapters\\chap1.doc"} 

{ RD "C:\\books\\Chapters\\chap2.doc"} 

{ RD "C:\\books\\Chapters\\chap3.doc"} 

If all the files are not in one directory, you must include the full path 

to the files; always use double backslashes to specify the path. If all the 

chapters, TOC and index files are in same folder, then just key in the 

chapter filename alone with \f switch. e.g., 

{ RD "chap1.doc" \f} 

{ RD "chap2.doc" \f} 

{ RD "chap3.doc" \f} 



6 Book Title 

 

RD fields that reference a series of files must be in the order in which 

the files are to appear in the project, e.g., files Chap1 and Chap2 both 

have an index entry for "apricot" on the first page. The first page number 

in Chap1 is 1, and the first page number in Chap2 is 100. 

 
Sequence Results in index entry 

{ RD 01chap1 } 

{ RD 02chap2 } 

{ RD 02chap3 } 

 

apricot 1, 100, 200 

{ RD 02chap2 } 

{ RD 01chap1 } 

{ RD 01chap3 } 

 

apricot 100, 1, 200 

Sec 1.17   has more information on RD fields and indexing. 

1.4   Macros 

The WSPC templates contain a number of macros, written to help you 

prepare the document conforming to WSPC guidelines. The usage of 

these macros have been explained clearly in this document for the benefit 

of authors using MS Word WSPC template. Although, all macros were 

thoroughly tested in different environments, the probability of the 

document getting modified in such a way that a macro persistently fails 

to work as expected. In this case, save and exit the document, and open a 

new document (based on the WSPC template) and copy the saved 

content into this document before running the macro again. 

1.4.1   Changing Word’s Macro Security Level 

By default, the Macro security level in Word is set to High. This means 

that Word will disable all macros unless one of the two criterias are met: 

 

• the macro has a digital signature from a trusted source or 

• the macro was created by the copy of the program installed on your 

computer. 

 

To change the macro security level and enable the WSPC macros: 
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For Office 2003, XP  and Office 97 users: 

(i) On the Tools menu, point to Macro, and then click Security. 

(ii) Click the Security Level tab, and then select the security level 

you want to use. 

(iii)  Click OK 

A word of caution: Even with the best, most up-to-date virus protection 

software installed on your computer, it is NEVER advisable to select the 

Low security setting. At the Medium security level, you will still be able 

to run unsigned macros, but Word will prompt you first. 

 

High - Macros are disabled. 

Medium - Users are prompted to enable or disable macros. 

Low - No prompt. Macros are enabled. 

 

For Office 2007 Users: 

(i) Click the Microsoft Office Button, click Word Options, and 

then click Trust Center. 

(ii) Click Macro Settings. 

(iii) Under Macro Settings, click Enable all macros. 

1.5   Body text 

1.5.1   Parts 

A part heading is always centered, odd-numbered page (recto) and 

should be set in boldface. (Note: Avoid setting Drop folio in part title 

page without text.) It is mandatory to leave the following page blank that 

is even devoid of folio or running head. Each part is then further 

subdivided into chapters and sections. 

1.5.2   Chapters 

Each chapter should normally be in a separate file. The chapter title 

should be typed in with the first letter of important words capitalized. 

Chapter and Section Numbers can be updated by selecting the current 
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chapter number and clicking the WSPC toolbar, Chapter | Change 

Chapter Number. Chapters usually starts on odd page, but for books 

with more than 500 pages you may run on the page numbers. 

1.6   Major Headings 

Major headings should be typeset in boldface with the first letter of 

important words capitalized. For already created content, you may switch 

off the section auto numbering option by clicking . This is to avoid 

the double numbering. 

1.6.1   Sub-headings 

Sub-headings should be typeset in boldface italic and capitalize the first 

letter of the first word only. 

1.6.1.1   Sub-subheadings 

Typeset sub-subheadings in medium face italic and capitalize the first 

letter of the first word only. 

1.7   Lists 

Lists may be presented with each item marked by bullets or numbers. 

The order of subdivisions of items in bulleted or numbered lists may be 

presented as follows: 

1.7.1   Bulleted items 

• item one 

• item two 

− sub-item one 

− sub-item two 

• item three 

• item four 
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1.7.2   Numbered items 

(1) First item in the first level 

(2) Second item in the first level 

(a) First item in the second level 

(b) Second item in the second level 

(3) Third item in the first level 

1.8   Equations 

Below is a sample equation created with Equation Editor. An equation 

should be typed as <tab>Equation<tab>(Equation number) 

then choose the style "Equation" from the styles list box on the tool bar 

or by clicking  from WSPC Toolbar. 

 1 1

2 3

2 3

cos , cos .
d F d F

SAm SAm
d d

ω ω
ω ω

      
= =  (1.1) 

The equations are typeset in 11 pt size, centered with equation 

numbers right aligned. In MathType please set the font size to 11 pt by 

selecting the MathType menu Size | Define. When the Define Sizes 

dialog appears, set the value for Full as 11 pt. 

1.9   Tables 

Position tables and figures top or bottom of a page where their first 

reference is cited in the text. Do not put them at the end of the chapter. 

Table 1.1. Single lined table captions are 

centered to the table width. Long captions are 

justified to the table width manually. 

NP 

  3 4 8 10 

 3 1200 2000 2500 3000 

NC 5 2000 2200 2700 3400 

 8 2500 2700 16000 22000 

 10 3000 3400 22000 28000 
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Tables are numbered sequentially within each chapter following 

corresponding chapter number and referred to in the text by number. 

Each table should have an explanatory caption which should be as 

concise as possible. If a table is divided into parts they should be labeled 

as (a), (b), (c), etc., but there should be only one caption for the whole 

table, and seldom separate ones for each part. 

Table 1.1 demonstrates a classic example of typical WSPC style 

table. The WSPC house style for tables is lucid enough for authors to 

follow the instructions that are elucidated below, but, in books, authors 

may follow their own format if they prefer, provided the result is both 

pleasing, in aesthetic sense as well as the style applied is observed 

consistently throughout the book. 

Tables can be created quickly by using the WSPC Table macros 

found at WSPC toolbar or Insert Table command, or using the Draw 

Table tool to create a more complex table—for example, one that 

contains cells of different heights or a varying number of columns per 

row. As stated previously, the WSPC table style is simple, comprising a 

bold Top-rule; a bold bottom-rule; and a thin mid-rule but seldom a 

vertical rule. 

1.10   Figures 

Word allows the placement of what is termed as a “frame” around a 

figure, a table, or any other element of the document so that its position 

 

Fig. 1.1. By default, figure captions are justified to the text width. Center this text if 

caption does not run for more than one line. 
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on the page is fixed. To comprehend the usage of this Word functionality 

in order to achieve the desired result, look up the various entries under 

Frames in the on-line Help. Frame is a container that you can resize and 

position anywhere on the page. To position graphics and their caption, 

you may use a frame. Select a figure along with its caption and click 

WSPC toolbar Figure | Bind Figure and Caption to create a frame box. 

1.11   Math Environments 

Math environment comprises Example, Description, Lemma, Proof, 

Remark, Corollary, Theorem, and Proposition. Each math environment 

holds individual numbers, following their own chronological order 

within their domain. Among the list of environments mentioned above, 

only Proof, Example and Definition are set in Roman font while the rest 

are set in italics font. However, similarity lies in headings, where all 

heads are set in boldface and separated from run on text by 1 em space. 

 

Theorem 1.1   Sample theorem text. 

 

Lemma 1.1   Sample lemma text. 

 

Theorem 1.2 (Optional Heading)   Sample theorem text. 

 

Proof.  Proof environment ends with a square box, denoting the end of a 

given proof. □ 
 

Proof. [Proof of Lemma] Proof environment ends with a square box, 

denoting the end of a given proof. □ 

1.12   Quote 

Sample quote. 

Quote text is indented by 1pc on left and right side. The point size for the quote 

text is 9/11pt. The above and below side for the quote is half-line. 
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1.13   Boxes 

Here is the example for the Boxed text. 

This is the example for the Box text environment. The text will be placed 

inside a box with 6pt space on all sides. The box rule thickness is .5pt. 

1.14   Appendices 

Appendices should be used only when absolutely necessary. They should 

come before the References. If there is more than one appendix, number 

them alphabetically. Number displayed equations occurring in the 

Appendix in this way, e.g.~(A.1), (A.2), etc. 

 1 1

2 3

2 3

cos , cos .ω ω
ω ω

      
= =

d F d F
SAm SAm

d d
 (A.1) 

1.15   References and Citations 

1.15.1   Unnumbered references 

References cited in the text should be placed within square brackets and 

state as [surname of author(s), year of publication], e.g., [Smith, 1964], 

[Smith and Thomas, 1964] and, with three or more authors, [Smith et al., 

1964]. If the reference reads as part of the sentences, the square brackets 

enclose only the year of publication, e.g., “According to Smith 

[1964],…” 

A complete list of references cited, arranged in alphabetical order 

according to the surname of the first author, should be provided. 

References by the same author will follow a chronological sequence, i.e., 

Smith [1969] precedes Smith [1971]. Article titles should be stated in full 

but standard abbreviations should be used for journal names. 

Journal reference: 

Burke, J. E. (1964). Scattering of surface waves on an infinitely deep fluid, J. Math. 

Phys., 6, pp. 805–819. 
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Book reference: 

Golub, G. H. and Van Loan, C. F. (1989) Matrix Computations, 2nd Ed. (Johns Hopkins 

University Press, USA). 

Lie, D. Y. C. and Wang, K. L. (2001) Semiconductors and Semimetals 73, eds. 

Willardson, R. and Weber, E., Chapter 4 “Si/SiGe Processing,” (Academic Press, 

San Diego) pp. 151–197. 

Proceedings reference: 

Hattori, M. and Matsumoto, H. (1977). Hydraulic performances of a submerged plate as 

breakwater, Proc. 24th Japanese Conf. Coastal Eng., JSCE, pp. 266–270 (in 

Japanese). 

Imai, T., Akiyama, Y., Ikeya, T., Kudo, K. and Tsuzuki, S. (1987). Wave focusing by a 

submerged crescent plate, Proc. Coastal Eng. JSCE: 487–491 (in Japanese). 

1.16   Numbered references 

References cited in the text should be placed within square brackets and 

state as [reference number], e.g., [1], [1,3] and, for contiguous entries 

with a range, [1–4]. A complete list of references cited, arranged in 

alphabetical order according to the surname of the first author, should be 

provided. References by the same author will follow a chronological 

sequence, i.e., Smith [1969] precedes Smith [1971]. Article titles should 

be stated in full but standard abbreviations should be used for journal 

names. 

Journal reference: 

1. Burke, J. E. (1964). Scattering of surface waves on an infinitely deep fluid, J. Math. 

Phys., 6, pp. 805–819. 

Book reference: 

2. Golub, G. H. and Van Loan, C. F. (1989) Matrix Computations, 2nd Ed. (Johns 

Hopkins University Press, USA). 

3. Lie, D. Y. C. and Wang, K. L. (2001) Semiconductors and Semimetals 73, eds. 

Willardson, R. and Weber, E., Chapter 4 "Si/SiGe Processing," (Academic Press, 

San Diego) pp. 151–197. 
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Proceedings reference: 

4.  Hattori, M. and Matsumoto, H. (1977). Hydraulic performances of a submerged 

plate as breakwater, Proc. 24th Japanese Conf. Coastal Eng., JSCE, pp. 266–270 (in 

Japanese). 

5.  Imai, T., Akiyama, Y., Ikeya, T., Kudo, K. and Tsuzuki, S. (1987). Wave focusing 

by a submerged crescent plate, Proc. Coastal Eng. JSCE: 487–491 (in Japanese). 

1.17   RD fields and Indexing
a
 

Creating the index entries and combined index: 

(1) Page Number all the chapters sequentially. Make sure that all the 

chapters' pages are numbered continuously. 

(2) Mark index entries in subdocuments (chapters) 

(iv) Select the text you want to include as an index entry. To enter 

your own text as an index entry, just click where you want to 

insert the index entry. 

(v) Press ALT+SHIFT+X or from WSPC toolbar Index | Mark, 

Mark Index Entry dialogue appears. 

(vi) To create a main index entry, type or edit the text in the Main 

entry box. To create a subentry, type the text in the Subentry 

box. To include a third-level entry, type the subentry text 

followed by a colon and the text of the third-level entry. 

(vii) To mark the index entry, click Mark. To mark all occurrences 

of this text in the document, click Mark All. 

(3) Attaching the subdocuments (chapters) to master file by creating 

RD fields: 

(i) Please make sure that all the individual chapters are already 

marked with index entries. Also make sure that all the 

chapters' page numbers are numbered continuously. 

(ii) In ws-bk9x6_master.dot, turn ON the Show/Hide button . 

You can copy, paste and edit our sample RDs field provided 

                                                      
a  http://office.microsoft.com/en-us/word/HP012264991033.aspx?pid=CH1006636033 



 Typesetting a Book in WSPC Style Using MS Word 15 

 

right next to <include all chapters here using RD Fields> or 

alternately can create the new ones as described below. 

(iii) Press Ctr + F9, an empty Field brackets  will appear. 

(iv) Now type in the text "RD" followed by a space and the 1st 

chapter's filename with full path. e.g., 

(v) { RD "c:\\job\\books\\NM\\chap1.doc" }. 

(vi) If all the chapters and the master file are in same folder, then 

just key in the chapter filename alone with \f switch. e.g., 

{ RD "chap1.doc" \f}. 

(vii) Similarly create the RD fields for all the other chapters. 

(4) Generating index list (To update an existing Index list, place the 

cursor over that Index list and press F9): 

(i) In Index page position the cursor where you want to insert the 

index. 

(ii) On the Insert menu, click Index and Tables, and then click 

the Index tab. or press Index Maker from WSPC toolbar. 

Press OK to create the index. 

Once including all the chapters via RD fields in your master file, press 

F9 button to update your combined Table of Contents. 


